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New User Invitation Email 

3 

What It Looks Like 

Important information to note 

1. Title of Tender/Proposal 

2. Start & End Times 

3. How to Respond 

Note: Make sure you access the Ariba Login page by clicking the ‘Click Here’ link in the event invitation email you 

received 



About Ariba and Ariba Commerce 
Cloud 
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What is the Ariba Commerce Cloud? 
  
 Ariba is a business commerce network that allows buyers to store contracts; submit and evaluate tenders; and for suppliers 

to complete the Synergy accreditation pack online. It is a worldwide company that is part of the SAP Company, with over 
1,300 buyers and 700,000 sellers using and transacting worldwide. 

 
 As a respondent to a Synergy tender, you will be asked to register for the Ariba Commerce Cloud, to be able to submit your 

tender response via Ariba. 
 
 The Ariba Commerce Cloud is a website that allows you to submit your tender responses online. You will have one login and 

one account that will allow you to submit tenders online with all of your customers transacting through Ariba.  
 
 If you already have an Ariba Commerce Cloud, Ariba Network or Ariba Discovery account, you can link your sourcing events 

to your existing Ariba user ID. 
 
Ariba Commerce Cloud Profiles 
  
 Sellers now have a single company profile in the Ariba Commerce Cloud, shared across all Ariba On-Demand solutions and 

visible to all their potential and existing buyer relationships. Ariba Commerce Cloud profiles include company account and 
configuration settings, company profile information, and user information. Ariba Commerce Cloud profiles allow you to 
maintain a single company profile, from one account, for all your customer relationships. 

 
Registering on the Ariba Commerce Cloud 
 
 How to register: please see the information on slides 5 & 6 for instructions on how to register for the Ariba Commerce Cloud 

 

 

 



How to Access Sourcing Events the First 
Time You Receive an Email Invitation 
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What It Looks Like 

After clicking the link in the event email invitation, Ariba displays the welcome to Ariba Commerce Cloud page as below.  

Perform one of the following Actions 

1. 'Continue' to enter your Ariba Commerce Cloud account 

and user information and complete the registration 

process. 

2. Click the here in ‘Click here if you already have an Ariba 

Commerce Cloud, Ariba Discovery, or Ariba Network 

account' to link your sourcing events with your existing 

account. 



Complete Registration (First Time 
User Only) 
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What It Looks Like 

After clicking Continue, the Ariba Commerce Cloud Registration Page will be displayed: 

What It Means 

 
• Enter your basic company information 

and your user account information. Keep 

the following in mind: 

 
• The Products and Service Categories 

fields are required to be filled in, in 

order to complete registration. 

However, you can change these 

values at any time in your Company 

Profile. 

 

• Note: If you cannot find the commodity 

that best represents your business 

please select the next best alternative.  

 

• The Tax ID and Dun and Bradstreet 

Number (DUNS) fields are optional 

and can also be updated at any time in 

your Company Profile. 

 

• If you require further explanations on 

specific fields consult the relevant 

information icons 

 



Registering a User 
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What It Means 

• Enter your desired user account 

details.  

• Note: The Username field must be in 

email format.  

• The person whose name is entered in 

the user account information section 

becomes the account administrator 

automatically. Account administrators 

can transfer the Administrator role to 

another user later. 

 

• Read the Terms of Use and Privacy 

Statement and click the check box if 

you agree to the terms. 

 

• Click Submit. 

 

• If you require further explanations on 

specific fields consult the relevant 

information icons 

 



Completing Registration 

8 

 What It Means 

• You may receive the Confirm Domain 
prompt if your email address does 
not match your business name. Click 
on the Yes button to proceed.  

• Then click on Go to Company Profile 



Synergy Accreditation Requirements 
 What It Means 

 

• The Synergy Requested Profile input 
screen is displayed. Please answer the 
questions provided. Be sure to Save as 
Draft if you are leaving your computer 
for an extended period to ensure you 
do not lose information  

• Once you have completed the initial 
accreditation requirements, click on 
Submit  

• If you have missed any information you 
will receive an error message advising 
what you have missed.  
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Updating your Synergy Accreditation 
Requirements 
 What It Means 

 

• You may need to update your Synergy information such as bank details or address or insurance information.   

• To go back into these fields click on ‘View customer requested fields’. Once updated hit ‘Submit’. 
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Invitation Email to Suppliers Already 
Registered on Ariba Commerce Cloud 
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What It Looks Like 

If you have previously registered on Ariba Commerce Cloud and you are invited for another event, you will receive an 

invitation email as follows.   

Important information to note includes: 

1. Title of Tender/Proposal inc. Start and 

End Times 

2. How to Respond 

3. User ID 

4. How to Decline 

5. Sourcing Specialist Contact Details 



Logging in to Ariba 
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What It Looks Like 

Enter your existing 

Ariba Commerce 

Cloud or Ariba 

Network username 

and password. 

Click ‘Login’ 

If you do not remember 

your username or 

password, follow the 

'Forgot Username’ or 

‘Forgot Password', Find 

the steps in the following 

slide. 



How to Reset Your Password 
or Retrieve Your Username 
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What It Looks Like 

If you forget your password or username, you can now have your username sent to your e-mail and reset your password  

without contacting Ariba Customer Service. 

 
What It Means 

 
 Select 'Forgot Password' or ‘Forgot Username’ on the login page 

 

 For username, type in your e-mail address and your username will 

be sent to the e-mail address on record. If you do not receive an e-

mail immediately, check your spam filter 

 

 For password, you will be taken through the password reset wizard, 

where you will be asked to answer the secret question you set up in 

your user profile 

 

 After you answer correctly, type in your new password and confirm. 

 

 

 
 



Accessing Bid Event/s 
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What It Looks Like 

After successfully logging into Ariba, your home screen will look as below.  

Click on the event you have been invited to 



Review Event Details 
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What It Looks Like 

This is the Home screen for the RfX event you have been invited to participate in. 

Important information to note includes: 

1. 1. Checklist  

2. 2. Event Overview and Timing Rules 

3. 3. Time Remaining 

4. 4. Review Prerequisites button 

 

1 

2 

3 

4 



Accepting the Pre-requisites 
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Important information to note includes: 

1. 1. In order to bid you must Accept the Bidder 

Agreement. 

2. 2. If there is an NDA Requirement you must 

download the Reference document and complete it. 

3. 3. Attach the completed NDA 

4. 4. Click ‘OK’ 

 

1 

2 
3 

4 



Intend to Participate 
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What It Looks Like 

This is the Home screen for the RfX you have been invited to participate in. 

Click the “Select Lots”  button to 

indicate if you intend to submit a 

tender response. 

Make sure you select the box next to 

all pricing you wish to bid for and click 

on ‘Submit Selected Lots” 



Response Screen 
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What It Looks Like 

This is the Response Screen that you will see once you are in the “Submit Response” stage of the Checklist. 



Decline to Respond 
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What It Looks Like 

Click ‘Decline to Respond' if you do not wish to 

respond to the tender.  



Decline to Respond cont. 
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What It Looks Like 

Please enter the reason for declining  



Deciding to Respond After Initially 
Declining  
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What It Looks Like 

Once you have declined to respond your access to the event will be temporarily removed. If you decide to respond to this 

event later, click the ‘Intend to Respond’ button for this event.  

Click ‘Intend to Respond’  



Ariba Message Inbox 
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What It Looks Like 

All event-specific messages sent to and from you are stored in your Ariba Message Inbox. 

Note: Messages with attachments sent to users from Synergy can be downloaded from the relevant message in ‘Event 

Messages’.  

To view this inbox click the ‘Event 

Messages’ link in the top left  

hand corner of the screen. 

 

 

 

 

 
 



Ariba Message Inbox 
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What It Looks Like 

Here you will find all the messages relating to this specific Tender/Proposal. 

To view a message, click 

on the radio button to the 

left of the chosen message, 

and click the 'View’ button. 

From this screen you can: 

1. 1. View a message 

2. 2. Reply to a message 

3. 3. Compose a new message 

4. 4. Download all attachments from all   

messages 

5. 5. Go back to the event home screen “Back to 

Console” 

 You can send a new message to the 

Sourcing Specialist in charge of the 

event at any time by simply clicking 

the 'Compose' Message button at the 

bottom of the screen. 



Ariba Message Inbox 
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What It Looks Like 

Here you can see the details and content of the message. You also have the opportunity to reply to the message by 
clicking the ‘Reply’ button. 



Compose Message 
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What It Looks Like 

You can type any message that you would like to send to the procurement person in charge of the event and 

attach any file where appropriate. The 'Subject' field is automatically filled, but feel free to edit the Subject 

to notify the Sourcing Specialist about what the message is related to. 

Once you are ready to send 

the message, click the blue 

'Send' button. 



Download an Attachment 
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What It Looks Like 

For some sections you may be required to download reference files either solely for your information or for editing and 

submission. 

1. Click the Specific  

document link in 

the event.  

 

2. Then click the 'Open' button to view the document or 

the 'Save' button to save the document to be viewed 

and worked on later. 



Download All Attachments 
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What It Looks Like 

An easy way to look through all the Tender/Proposal documents and save them to your PC is to Download All 

Attachments. Note: Using this option you can also download specific documents.  

1. Click on any document link 

in the event.  

2. Then click 

'Download 

all attachments' link 



Download All Attachments 
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What It Looks Like 

After clicking on 'Download all attachments' you will arrive at the following screen 

1.  Click on the boxes individually to 

select specific documents to 

download 
2.  Click on ‘Download 

     Attachments' link after 

you have made your 

selection 

3. Then click the 'Open' button to view the document or 

the 'Save' button to save the document to be viewed 

and worked on later. 



Download Reference File 
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What It Looks Like 

For some sections you may be required to download an individual attached file either solely for your information or for 

editing and submission. 

3. Then click the 'Open' button to view the document or 

the 'Save' button to save the document to be viewed 

and worked on later. 

1. To download files attached as 

references, 

click the 'References' link. 

2.  Then click 

on the relevant 

document/s. 



Attach a File 
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What It Looks Like 

For some sections you may be required to attach files supporting your response.  

Note: To attach multiple files, create a folder on your computer with all of your documents in it and zip this folder. The zipped 

folder can then be attached in Ariba. 

Click 'Attach a File' link 



Attach a File 
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What It Looks Like 

1. Using the ‘Browse’ button 

find and select the file you 

wish to attach 

 

 

 

2. Once selected, click the 'OK' 

button to attach the file. 

 

 

 

 

 



Attach a File 
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What It Looks Like 

You should now 

see the file 

attached where 

the 'Attach a file' 

link was. 

You now also have 2 options. You can: 

'Update file' –  re-attach the same or another file. 

'Delete file' – delete the currently attached file. 



Adding Comments 
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What It Looks Like 

When responding to the Tender/Proposal, you can also add additional comments to attached files within 

Ariba. 

     To do this, simply click on 

the speech bubble 

picture of the 

corresponding 

attachment. 



Adding Comments continued 
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What It Looks Like 

     Type in your comment. 

You can also attach 

another file if required.  

When finished 

click OK.  



Save Work in Progress 
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What It Looks Like 

At any stage you can Save your response so that you can work on it at a later date. If you don’t click save before leaving the 

system, or if you leave it for too long without any activity you will lose any work unless you hit ‘Save’. 

To do this all you need to do is click the 'Save' button. Once this is done you may log 

out knowing your response (including attachments) has been saved for when you login next. 



Submit Response 
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What It Looks Like 

When you are ready to Submit your Response you can click on the blue 'Submit Entire 

Response' button at the bottom of the screen.  



Submit Response 
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What It Looks Like 

If your response is complete and there are no errors, a popup box will appear asking you to confirm your submission.  

Click 'OK' to 

submit your 

response. 



Submit Response 
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What It Looks Like 

If your response has been submitted correctly you will see a green bar at the top stating that “You have submitted a 

response for this event.”  



Submission Errors 
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What It Looks Like 

If you have failed to answer any of the questions or attach documents where required you will be notified of each 

error. Please ensure you allow time to check you have filled all fields in correctly so you can submit your 

response before the due date/time. 

Errors will be  

highlighted in red and 

an explanation will 

accompany them. 



Revise Response 
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What It Looks Like 

After submitting your response you can go back and revise your response, provided the event has not yet closed. 

This can be done by clicking the blue 

'Revise Response' button 

at the top of the screen. 



Revise Response 
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What It Looks Like 

You will then be asked to confirm whether you would like to revise your response or not. 

If you still wish to proceed, click the 'OK' button. 

 

You will be then shown your Response Screen and all answer fields will 

be unlocked and available for editing. 

 

Do not forget to select ‘Submit your entire Response’ again once 

complete. 



Printing Your Response 
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What It Looks Like 

If you wish to keep a hard copy of your response it can be exported from Ariba and printed. 

 

2. Then click on the 

'Export all Rows' link. 

3. Clicking the 'Open' button in the File  

Download popup window will then open up  

your response in Microsoft Excel. 

1. Click on the table 

icon in the top right 

hand corner of the 

response table. 



Printing Your Response 
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What It Looks Like Here you will see the whole response 

To format it so that it prints properly click the 'View' menu at the top of  

the window and select 'Page Break Preview' from the dropdown list 



Printing Your Response 

44 

What It Looks Like 

Then left click the first vertical  

dashed blue line from the left and  

hold the button as you drag it to the  

right, in line with the solid blue line  

on the far right. Do the same with  

the second vertical dashed blue line 

 



Printing Your Response 
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What It Looks Like 

1. Right click the B of Column B. 

2. And from the drop down 

list select Delete 



Printing Your Response 
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What It Looks Like 

2. Left click on the arrow next to the           icon. 

 

1. Press the Ctrl and A keys on your 

keyboard at the same time (Ctrl+A). This  

will highlight all the text. 

 

3. From the drop down list select the All 

Borders       icon. 

 

4. Then left click the 'File' menu at the top of 

the window, and from the drop down list 

click the 'Print' option. 

 



Ariba Help 
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What It Looks Like 

Ariba branded help Guides and Tutorials 

can be found using the 'Help' dropdown  

menu in the top right-hand corner of the 

screen. Here you  can also find contact 

information for Ariba 

For Ariba related issues you can contact Synergy at  

ariba.admin@synergy.net.au. 

 

Alternatively you can contact Ariba directly on 1800 766 694 

mailto:ariba.admin@synergy.net.au

